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Introduction

The Nonpoint Source Pollution and Erosion Comparison Tool (N-SPECT) examines the
relationship between land cover and nonpoint-source pollution and erosion. N-SPECT is an
extension to Environmental Systems Research Institute’s (ESRI) ArcGIS software package,
version 9.2, and requires ESRI's Spatial Analyst extension. N-SPECT is designed for use with
any watershed, provided the user has access to the necessary data. This user’'s manual provides
a detailed description of the interfaces within N-SPECT and the data required to perform an
analysis. The technical guide explains in more detail where the data that are distributed with
N-SPECT were acquired and how the data were processed to be compatible with N-SPECT.

N-SPECT uses spatial elevation data to calculate flow direction and flow accumulation throughout
a watershed. To do this, land cover, soils, and precipitation data sets are processed to estimate
runoff volume at both the local and watershed levels. Coefficients representing the contribution of
each land cover class to the expected pollutant load are also applied to land cover data sets to
approximate total pollutant loads. These coefficients were derived from a combination of relevant
studies and local water quality sampling data or taken from published sources. The output layers
display estimations of runoff, pollutant loads, pollutant concentration, and total sediment loads.
These layers can help resource managers make informed decisions about water quality and what
areas to target for improvement, as well as predict the impacts of management decisions on
water quality. N-SPECT also provides functionality to compare current land cover conditions to
proposed changes in both land use and land cover.

Note: Data provided with N-SPECT are for the Wai'anae area, located on the western side of
O*ahu, Hawai'i. The Technical Guide explains in more detail where the data were acquired for the
Wai‘anae study area and how the data were processed to be compatible with N-SPECT.



1. Getting Started

1.1 Installing N-SPECT

N-SPECT was originally developed to run on ArcGIS 8.x and has since been updated to run on
ArcGIS 9.x. The most recent version is compatible with ArcGIS 9.2 and requires a two-step
process to install the correct version of the tool. The tool must be installed by an administrator.
The following steps assume that the user is operating ArcGIS 9.2. If an older version of ArcGIS is
being used, go to the N-SPECT website for installation instructions and earlier versions of the tool
(www.csc.noaa.gov/crs/cwg/nspect.html).

1. Run the installation file for N-SPECT for ArcGIS 8.3 by double-clicking on the file,
installed anzloar_c:\_drive.

2. Extract the installation files for N-SPECT for ArcGIS 9.2 by double-clicking on the file,
setup.exg. Follow the prompts and an updated version of the NSPECT.dIl will be written
to your C:\NSPECT\bin folder.

Note: If a previous version of N-SPECT is already installed, it should be removed before installing
a new version. To uninstall the previous version, use the function Add/Remove Programs in the
Control Panel, select N-SPECT, and click Change/Remove. Then follow the instructions from the
wizard to uninstall the tool. Check the location where N-SPECT was installed and make sure it is
empty (the directory will not be deleted, which is fine).

1% NSPECT - InstaliShield Wizard
Ready to Install the Program ‘.- a
The wizard is ready to begin installation, ‘ -

Click. Install to begin the installation,

If wou wank ko review or change any of your installation settings, click Back, Click Cancel ko
exit the wizard,

« Back ][ Inskall ] [ Cancel




1.2 Loading N-SPECT

e Open ArcMap and create a new empty map or open the desired ArcMap project.

¢ Right-click on the menu bar to reveal the context menu showing available tools. Check
the box next to N-SPECT to turn it on.

Note: The toolbars can also be accessed under View > Toolbars. Put a check by N-SPECT. If the
N-SPECT menu does not appear in the list, click on Customize and complete the following steps:

e Inthe Customize dialog that appears, click on the Add from file button.

e Navigate to NSPECT.dIl (installed by default under C:ANSPECT\bin), and click on Open
to select the file.

e Adialog box will appear informing you that the tool has been added to ArcMap.
Click OK.

e Click on the Close button. You should now see the N-SPECT toolbar added to ArcMap.

The main N-SPECT menu is shown below.

MN-SPECT [...| |

M-5PECT =

Run Analysis. ..

Advanced Settings Land Caver Types. ..

Help. .. Pollutants. ..

Waker Quality Skandards., .,
Precipitation Scenarios. ..
Watershed Delineations. ..

Soils. ..

Note: It is not necessary to activate the Spatial Analyst extension because it will be automatically
activated when N-SPECT is loaded. To verify that it has been activated, click Tools > Extensions.
The Spatial Analyst extension will be checked when N-SPECT is in use.



2. Running an Analysis

2.1 Setting Up a Project

Use the Run Analysis option on the main N-SPECT menu to N-SPECT [...| |
define all parameters required to perform an analysis within a
defined region. M-SPECT *
Use the File menu to create a new project, or open an existing Run Anialysis...
project file. Use the Pollutants tab to define which pollutants to Advanced Settings B
include in the assessment. Use the Erosion, Land Uses, and
Management Scenarios tabs to specify optional parameters to Help...
consider in the analysis.
3 Example Project g ml| >
File Help
Project Information A
M ame: |E:-:am|:||e Project Working Direchany: JEZ"-\.NSPEET"\WDrkSpaDE E‘
Land Covver Soils c Mizcelaneous D
Grid Ilandcnver LJ Soils Definition; )
B i"-.-'-.-"aianae LJ
Bl | —J Hydralogic Soils Dataset: | J
Type: |EE.-'-‘-.F' LJ C:AMSPECT YW aianaeDatah 501151 [ ifioesl Elfacs Dl
Precipitation 5 cenarno E "W aterzhed Delineation F W' ater Quality Standard G
M arrie: I.-'i‘-.nnual Precipitation :_J M ame: |Waianae LJ M armie: |L|:|r'|g Termn Criteria j
Poll.tants l Eru:usiu:unl Land Llses1 ManagementScenarius]
Apply Follutant Mame Coefficient Set YWhich Coefficient
Phozpharuz PhozSet Type 1
O |Mitrogen
O | Total Suspended Solids
O |Zinc
O |Lead
Fun Cancel




Project Information:

Name: To save the parameters in a project file, designate a name for the project when a
new project is created or an existing project is modified. The parameters that are used in
each analysis are saved in this project file, which is in .xml format. Be sure to save the
project under a new name each time you make changes, or the original project
parameters will be lost.

Working Directory: Designate a working directory for your project. The working directory
will default to C:\NSPECT\workspace.

Land Cover:

Grid: Select the land cover grid that will be used in the analysis. The field contains a
drop-down list of all grids loaded in the ArcMap project.

Grid Units: Select the units (meters or feet) for the selected land cover grid.

Type: Select the land cover type that matches the selected land cover grid. The drop-
down list contains all currently defined land cover types (see Advanced Settings, Land
Cover to learn how to add a land cover type).

Soils:

Soils Definition: Select the soils configuration that will be used in the analysis. The drop-
down list contains all currently defined soil configurations. The soil configuration specifies
the grid that contains spatial values for the hydrologic soil types in the area of interest
and the grid that contains spatial values for the K factor (soil erodibility factor) in the area
of interest (see Advanced Settings, Soils to learn how to add a soil configuration).

Hydrologic Soils Data Set: This shows the hydrologic soil type (A, B, C, or D,
depending on the soil’s infiltration rates) grid associated with the soil configuration
selected in the Soils Definition drop-down field.

Miscellaneous:

Selected Polygons Only: Select this check box to perform the analysis on a selected
area. The analysis will be performed in the entire watershed (or catchment basin) in
which the polygon is located, but the output will be clipped to the selected area. This
option is only active if a polygon data layer is loaded in the ArcMap project.

Local Effects Only: Select this check box to remove the influence of upstream cells from
the analysis. Local effects will only account for the runoff, pollutants, and sediment yield
generated at each cell, rather than incorporating the cumulative effects of upstream cells
in the watershed.

Precipitation Scenario: Select the precipitation scenario to be used in the analysis from
the drop-down list of all currently defined precipitation scenarios, or define a new
precipitation scenario (see Advanced Settings, Precipitation Scenarios to learn how to
add a precipitation scenario).

Watershed Delineation: Select the watershed delineation data to be used in the
analysis from the drop-down list of all currently defined watershed delineations, or define
a new watershed delineation (see Advanced Settings, Watershed Delineations to learn



how to add a watershed delineation). These water quality standards can be acquired
from state and local water quality regulatory agencies.

G | water Quality Standard: Select the water quality standard to be used in the analysis
from the drop-down list of all currently defined water quality standards, or define a new
water quality standard (see Advanced Settings, Water Quality Standards to learn how to
add a water quality standard).

H | File Menu: Use the File menu to create a new project, to open a previously defined
project, or to save a new or modified project. Select New Project to start a new analysis.
Select Open Project to open an existing project file. Fields in the project setup window
will be automatically filled with the information that was previously saved. Choose Save
or Save As to save the current project.

53 Example Project
File Help

Mew Project Chrl+M
Qpen Project,.,  Chrl+0

|

Save Chrl+5 So
Save As..., !
=

Exit Chrl+% '
Grd Ol | {
Type: CCep -] [
Precipitation Scenario e aterst

M arme; |.ﬁ.nnual Frecipitation ﬂ f amne:

2.2 Estimating Pollutant Loads

Use the Pollutants tab to define which pollutants to include and which coefficient set to apply in
the analysis. All the pollutants in the database with defined coefficient sets are listed in the table.

Pollutants l Eru:usiu:unl Land Llses] tanagement Scenarios ]
Apply Pallutant M ame Coefficient Set YWhich Coefficient
Phozphoruz PhozSet Type 1
O [Hitogen
O |Total Suspended Solids
O [Zinc
O |Lead
Fiun Cancel




Apply: To include a pollutant in the analysis, select the check box in the Apply column. To
exclude a pollutant from the analysis, clear the check box. The column defaults to cleared, which
means that the pollutant in that row will not be included in the analysis.

Pollutant Name: The Pollutant Name column is automatically populated with the name of all the
currently defined pollutants and cannot be edited in this window (see Advanced Settings,
Pollutants to learn how to add a pollutant).

Coefficient Set: Select the appropriate coefficient set for the pollutant from the drop-down list of
all currently defined coefficient sets for that pollutant (see Advanced Settings, Coefficients to
learn how to add a coefficient set).

Which Coefficient: Select the coefficient type (Type 1, Type 2, Type 3, or Type 4) to be used to
run the analysis. N-SPECT will apply that coefficient type to each land cover class in the area of
interest. If only one type of coefficient is available, select Type 1.

Once the pollutants are specified and the other parameters in the project setup window are
selected, the analysis can be run by pressing the Run button in the bottom right-hand corner of
the window. Erosion will not be included in the analysis unless the Calculate Erosion option is
activated on the Erosion tab (see next section).

2.3 Estimating Sediment Loads (optional)

Use the Erosion tab to indicate whether you want N-SPECT to calculate erosion. The content of
the erosion tab will change according to whether an event-based precipitation scenario or an
annual precipitation scenario is selected in the Precipitation Scenario field.

Event Type Precipitation Scenario: To include erosion calculations in the analysis, select the
check box beside Calculate Erosion for Event Type Precipitation Scenario.

Frecipitation Scenario Y aterzhed Delineation Water Gluality Standard

M ame: |Event Precipitation ﬂ RENI=R |Waianae j M ame: |L|:|ng Term Criteria j

Fallutant:  Erosion l Land Llses] Management Scenarias l

[v Calculate Erosion for Event Type Precipitation Scenario

k. Factor Datazet: C:ANSPECT YW aianaeD atabSOILSK]

Run Cancel

K Factor Data Set: This shows the K factor grid associated with the soils configuration
selected in the Soils Definition drop-down list. The K factor is an erodibility factor needed to
estimate soil loss. The erodibility factor is based on soil characteristics and can be acquired from



the Natural Resources Conservation Service (NRCS) Soil Survey Geographic (SSURGO)
database.

Annual Type Precipitation Scenario: To include erosion calculations in the analysis, select the
check box beside Calculate Erosion for Annual Type Precipitation Scenario.

Frecipitation Scenario YWaterzhed Delineation YWater Cluality Standard

MName: |Annual Precipitation ﬂ RENI=R |Waianae j M ame: |L|:|ng Term Criteria j

Fallutants Eru:usiu:unl Land Llses] Management Sn:enariu:usl

[v Calculate Erozion for Annual Type Precipitation Seenarc

K. Factor Datazet: C:ANSPECT YWwWaianaeD atab\SOILSK]

Rainfall Factor [~ Sediment Delivery Ratio GRID [optional]

* Use GRID: | | | I~
" Use Constant W alue;

Fiun Cancel

e K Factor Data Set: This shows the K factor grid associated with the soils configuration
selected in the Soils Definition drop-down list. The K factor is an erodibility factor needed
to estimate soil loss. The erodibility factor is based on soil characteristics and can be
acquired from the NRCS SSURGO database.

e Rainfall Factor: The Rainfall Factor frame becomes available if the selected precipitation
scenario is an annual precipitation scenario. The rainfall factor (also called the runoff
erosivity factor) quantifies the effects of raindrop impacts and reflects the amount and
rate of runoff associated with the rain. Rainfall factors can also be acquired from the
NRCS SSURGO data set. To use a grid, check Use GRID and select the appropriate grid
from the drop-down list of grids loaded in the ArcMap project. To use a constant value,
check Use Constant Value and enter a valid numeric value greater than zero. This
constant rainfall factor value will be applied for the entire study area.

e Sediment Delivery Ratio GRID: The Sediment Delivery Ratio (SDR) GRID is a raster
data set that is used to calculate the amount of sediment delivered from a cell. The
Universal Soil Loss Equation calculates the amount of sediment that is mobilized from an
area, and the SDR is used to adjust the amount of sediment that actually leaves a cell. N-
SPECT automatically calculates the SDR grid using the digital elevation model
associated with the specified watershed delineation when an annual erosion analysis is
run, but users are also encouraged to specify their own SDR grid here if one is available.

2.4 Incorporating Scenarios
2.4.1 Land Uses

Use the Land Uses tab to define a specific land use and new Soil Conservation Service (SCS)
curve number and pollutant coefficient set for a particular area. N-SPECT will use this new land



use scenario to calculate runoff, pollutant, and sediment loads in this area. The original land
cover grid values will be ignored in the calculation. For example, if a known area is a landfill, a
new land use type “landfill” can be defined with appropriate coefficients that are applied only to
that area.

Note: When both a land use scenario and a management scenario (see next section) are

selected for the same area, the management scenario will be performed first. The final result in
the overlapping area will reflect the land use scenario that was specified.

Puollutants l Erozion Land Uses | Management Scenarios ]

Apply Land |Jze Scenanio

O

Add Scenario. ..

Run Cancel

e Apply: Toinclude a land use scenario in the analysis, select the check box in the Apply
column. To exclude the land use scenario from the analysis, clear the check box. The
column defaults to cleared, which means that the land use scenario in that row will not be
included in the analysis.

e Land Use Scenario: The Land Use Scenario column on the Land Uses tab displays all
the land use scenarios that have been defined for the current project. Add, edit, or delete
a scenario by right-clicking within the table.

Add Land Use Scenario

A new scenario can be added to N-SPECT by right-clicking in the table on the Land Uses tab
and selecting Add Scenario from the drop-down list.



-

B3 Add Land Use Scenario g@
Scenario Mame: |new_|an|j_uge
Layer: | land_use_scenario j
SC5 Curve Numbers: | I | E | C | O
0 [ 0 [
Cover Factor, |0 [ WwWaterSwfetlands
| | | Coefficients
Follutant Type 1 Typed | Typed | Tuped
Phosphorus 1] 1] 1] 1]
Mitrogen 1] 1] 1] 1]
Total Suspended Solidz 1] 1] 1] 1]
Zine 1] ] 1] 1]
Lead 1] ] 1] 1]
] | Cancel |

Scenario: Provide a name for the new scenario being added (limit of 35 characters).

Layer: Select the polygon layer that delineates the area of your land use. The drop-down
list contains all defined polygon layers in the ArcMap project. The new land use type will
be applied to the entire selected layer.

Note: When both a land use scenario and a management scenario are selected for the
same area, the management scenario will be performed first.

SCS Curve Numbers: Designate Soil Conservation Service (SCS) curve numbers for
the new land use type for each soil type (A, B, C, and D). The SCS curve numbers
represent the infiltration of precipitation into the soil and are used when calculating runoff
and erosion. The water that infiltrates is not included in the flow accumulation
calculations; therefore, a more accurate prediction of the total runoff is provided. SCS
curve numbers are percentages entered into N-SPECT in decimal form as numbers
between 0 and 1; the higher the curve number, the greater the amount of runoff. The four
columns, A, B, C, and D, represent the curve numbers for each of the four hydrologic soil
types, which indicate the soil's minimum infiltration rate. Group A soils (typically sand or
gravel) have the highest infiltration potential, and Group D soils (typically clay soils) have
the lowest infiltration potential. Group B soils (typically silt with fine to moderately course
textures) have a moderate infiltration rate, and Group C soils (typically sandy clay with a
moderately fine to fine texture) have a low infiltration rate.

Cover Factor: Specify a cover factor for the new land use type. The cover factor is
defined as the ratio of soil loss from land under specified vegetative or mulch conditions
to the corresponding loss from tilled, bare soil. More dense cover slows water and
prevents it from flowing down a slope, quickly carrying sediment. The lower the cover
factor, the better the vegetative cover is at preventing erosion. The higher the cover
factor, the more erosion will result in that area. For example, grasslands generally have a
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much lower cover factor than bare land because the vegetation will help prevent soil
erosion.

o Water/Wetlands: Select the Water/Wetlands check box if the land use type is water or a
wetland. This information is required to accurately calculate erosion.

e Pollutant: Each pollutant that the user has defined within N-SPECT will be listed in the
pollutant column. This column cannot be edited.

e Coefficients: Specify a coefficient for each pollutant that may result from this land use
type. Only one type of coefficient must be specified. The Type 2, Type 3, and Type 4
columns can be used in cases where some phenomenon will cause the coefficients for
each pollutant to change.

2.4.2 Management Scenarios

Use the Management Scenarios tab to change the land cover within a specified region to a
different land cover class that is already defined in the land cover classification being used in the
analysis. For example, to estimate the impact of a new housing development, you can create a
polygon shapefile of the area that will be developed and apply the high- or low-intensity
developed land cover class to that specific area. The coefficients for the newly designated land
cover class will be used in these designated areas rather than the coefficients for the original land
cover data set.

Note: The original land cover data set will not be changed, but original coefficients will be ignored.
When both a land use scenario and a management scenario are selected for the same area, the
management scenario will be performed first. The final result in the overlapping area will reflect
the land use scenario that was specified.

Pnllutants] Eru:nsiu:nn] Land Uzes  Management Scenanios l

Apply Change area laper Change to class |
management_scenaria !High Intensity Developed j
High Intensity Developed e

Low [ntengity Developed

Cultivated Land

Grazsland

Ewvergreen Forest

Falustring Faorested 'Wetland
ScrubdShrub

IInconzolidated Shore bl

Run Caricel

e Apply: To include a management scenario in the analysis, select the check box in the
Apply column. To exclude the management scenario from the analysis, clear the check
box. The column defaults to cleared, which means that the management scenario in that
row will not be included in the analysis.
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e Change Area Layer: Select the polygon layer that will be changed to a different land
cover class. The Change Area Layer drop-down list contains all defined polygon layers in
the ArcMap project.

e Change to Class: Select the new land cover class that will be applied to the polygon

layer. The Change to Class drop-down list contains all land cover classes for the selected
land cover type.

F'u:nllutants] Eru:nsiu:nn] Land Uzes  Management Scenanios

Apply Change area laper Change to class |

t i High Intensity Developed !
. management scenano 1gn Intensity Develope Append Row

Insert Row

Delete Current Row

Run Cancel

Add Management Scenario

There are three options, available through a pop-up menu, to edit the management scenario
parameters. Access the pop-up menu by right-clicking within the table.

e Append Row: Add a new management scenario to the end of the table by selecting
Append Row from the pop-up menu that displays by right-clicking within the table. In the
Change Area Layer column, select the polygon layer denoting the area where the land
cover class will change. The column contains a drop-down list of all polygon layers
defined in the active data frame. Then select the new land cover class for the region.

e Insert Row: Insert a new management scenario into the table by selecting Insert Row
from the pop-up menu that displays by right-clicking within the table. In the Change Area
Layer column, select a polygon layer denoting the area where the land cover class will
change. The column contains a drop-down list of all polygon layers defined in the active
data frame. Then select the new land cover class for the region.

e Delete Row: Delete an existing management scenario by clicking on the appropriate row
and selecting Delete Row from the pop-up menu that displays by right-clicking within the
table. Confirm the choice to delete when prompted and the selected management
scenario and its associated information will be deleted from the database.

12



3. Advanced Settings

The Advanced Settings menu provides access to functionality for viewing, editing, and adding
region-specific data sets and parameters. Default data sets and parameters are defined for the
Wai‘anae region and have been provided with N-SPECT. Users in the Wai‘anae area that choose
to use the default data can skip the Advanced Settings section and go directly to the Run
Analysis menu selection. Users that want to use N-SPECT in other regions nationwide can use
the advanced settings to incorporate data from their local area.

3.1 Land Cover

Land cover data are the basis of N-SPECT’s functionality. Land cover is used to estimate
pollutant loads by applying coefficients for individual pollutants to each land cover class, and land
cover is used to estimate runoff and erosion using curve numbers associated with each land
cover class. N-SPECT was designed using C-CAP (Coastal Change Analysis Program) land
cover data; however, any land cover data can be used in the tool provided the appropriate
pollutant coefficients have been defined.

Use the Land Cover Types window to select the land cover type to be viewed or edited. All
currently defined land cover types are available via the Land Cover Type drop-down list. When a
land cover type is selected, the remaining fields are automatically populated with information
about the selected land cover type. Use the Options menu to create, import, delete, or export a
land cover type.

I3 Land Cover Types %
Cptions  Help
Land Cover Type: ||:|:,-'1'-.F' j
D escription: \CCAP Landoover
| Clazsification | SCS Curve Mumbers | RUSLE
Yalue| Hame CH-, CH-B CH-C CH-D CoverFactor|  ‘wet
2|High Intensity Developed neq 0.4z 094 0.95 ] O
3| Low Intensity Developed 0.E1 0.75 a3 0.av 0.03 O
4| Cultivated Land 0E7 0n7a 0.85 nea 024 O
5| Grazzland 039 0El 074 ne 005 O
7| Evergreen Forest 03 .55 0.7 077 0.004 O
9| Scrub/Shrub 03 043 0.5 073 004 O
10| Palustrineg Faorested *Wetland | 0 ] 1] I} 0.003 O
16| Unconsalidated Shore 1] ] 1] I} 0.5 O
17| Bare Land 077 086 0.91 054 nv7 O
18w/ ater 1] 1] 1] 1] 1]
Restore Defaultz Save Carnicel
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Land Cover Type: Use this to designate the land cover type. The box drop-down list contains all
currently defined land cover types within N-SPECT.

Description: A brief description of the selected land cover type. Provide a description (less than
100 characters) when importing or creating a new land cover type data set.

Classification: This column contains the grid value and corresponding name for each land cover
class in the currently selected land cover type. Provide values and names when creating a new
land cover data set.

SCS Curve Numbers: The Soil Conservation Service (SCS) curve numbers represent the
infiltration of precipitation into the soil. The water that infiltrates is not included in the flow
accumulation calculations; therefore, a more accurate prediction of the total runoff is provided.
SCS curve numbers are percentages entered into N-SPECT in decimal form as numbers
between 0 and 1; the higher the curve number, the greater the amount of runoff. The four
columns, CN-A, CN-B, CN-C, and CN-D, represent the curve numbers for each of the four
hydrologic soil types, which indicate the soil's minimum infiltration rate. Group A soils (typically
sand or gravel) have the highest infiltration potential, and Group D soils (typically clay soils) have
the lowest infiltration potential. Group B soils (typically silt with fine to moderately course textures)
have a moderate infiltration rate, and Group C soils (typically sandy clay with a moderately fine to
fine texture) have a low infiltration rate. For instances where a dual hydrologic group is assigned
(e.g., A/D, B/D, C/D), the highest curve number of the two components is used (see the N-
SPECT Technical Guide for a detailed description). Default values for C-CAP land cover data are
provided with N-SPECT. Provide SCS curve number values when creating a new land cover data
set.

Hydrologic Soil Group Definitions
Hydrologic Soil

Soil Group Characteristics
Group

Soils having high infiltration rates, even when thoroughly wetted, and
A consisting chiefly of deep, well-drained to excessively drained sands
or gravels. These soils have a high rate of water transmission.

Soils having moderate infiltration rates when thoroughly wetted and
consisting chiefly of moderately deep to deep and moderately fine to

B moderately coarse textures. These soils have a moderate rate of
water transmission.
Soils having slow infiltration rates when thoroughly wetted and

c consisting chiefly of soils with a layer that impedes downward

movement of water, or soils with moderately fine to fine texture.
These soils have a slow rate of water transmission.

Soils having very slow infiltration rates when thoroughly wetted and
consisting chiefly of clay soils with a high swelling potential, soils with
D a permanent high water table, soils with a claypan or clay layer at or
near the surface, and shallow soils over nearly impervious material.
These soils have a very slow rate of water transmission.

RUSLE: The Cover Factor and Wet columns are values used in the Revised Universal Soil Loss
Equation (RUSLE) to calculate erosion. The cover factor is typically a number between 0 and 1,
and is essentially the ratio of soil loss from land under specified vegetative conditions to the
corresponding loss from bare soil. The cover factor reduces the soil loss estimate according to
the effectiveness of vegetation in preventing detachment and transport of soil particles. The
higher the value, the more erosion occurs (e.g., bare land has a relatively high cover factor).
Default values for C-CAP data are provided with N-SPECT. Provide cover factor values when
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creating a new land cover data set. The Wet column designates whether the land cover type is
water or wetland. If the land cover class is water or wetland, the check box in this column should
be selected. For any non-water class, the check box should be cleared. This distinction is
necessary for an accurate calculation of erosion.

Add Land Cover Type

To create a new land cover type, select New from the Options menu.

-
& Land Cover Types
Dptions  Help
MEw- MPE |§new land cover v
Delete. .. o -
Import. .. : |new land cover type descriphic
Export... Clazzification |
YWalue| Mame M-
0] Landclass1 0

B3 Mew Land Cover Type

Land Cover Type:  |Mew Land Cover
Descrption: | Decsription of land coved
| Clazzification | SC5 Curve Mumbers | RUSLE
Yalue|Hame CH-4 CH-B CH-C CH-D Cover-Factar|  “Wet
0] Landclass1 0 0 i i o O
0| Landclazs2 1] 1] 1] 1] 1] O
- L i = o h 1] 0 ] 1] 1] O
— | AddRow
Insert Row
Delete Row
k. Cancel

Land Cover Type: Provide a name for the new land cover type being added (limit of 35
characters).

Description: Provide a brief description (less than 100 characters) of the new coefficient set.
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Classification: Input the grid value (Value column) and corresponding name (Name column) for
each land cover class in the new land cover type. To add, insert, or delete a row, right-click in the
table.

SCS Curve Numbers: Specify the Soil Conservation Service (SCS) curve numbers in the CN-A,
CN-B, CN-C, and CN-D columns. Curve numbers represent the infiltration of precipitation into the
soil. The four columns represent the curve numbers for each of the four hydrologic soil types,
which indicate the soil's minimum infiltration rate. The water that infiltrates is not included in the
flow accumulation calculations; therefore, a more accurate prediction of the total run-off is
provided. SCS curve numbers are percentages entered into N-SPECT in decimal form as
numbers between 0 and 1; the higher the curve number, the greater the amount of runoff.

Group A soils (typically sand or gravel) have the highest infiltration potential, and Group D soils
(typically clay soils) have the lowest infiltration potential. Group B soils (typically silt with fine to
moderately course textures) have a moderate infiltration rate, and Group C soils (typically sandy
clay with a moderately fine to fine texture) have a low infiltration rate. For instances where a dual
hydrologic group is assigned (e.g., A/D, B/D, C/D), the highest curve number of the two
components is used.

RUSLE: Specify the cover factor for each land cover type. The cover factor is typically a number
between 0 and 1, and is essentially the ratio of soil loss from land under specified vegetative
conditions to the corresponding loss from bare soil. The cover factor reduces the soil loss
estimate according to the effectiveness of vegetation in preventing detachment and transport of
soil particles. The higher the value, the more erosion occurs (e.g., bare land has a relatively high
cover factor).

Specify whether the land cover type is water or wetland in the Wet column. If the land cover class
is water or wetland, the box in this column should be checked. For any non-water class, the box
should be left unchecked. This distinction is necessary for an accurate calculation of erosion.

Delete Land Cover Type

-
3 Land Cover Types
Options  Help
Pew... MpE: |§new land cover v
Delete... Hion: —
Import. .. . |new land cover type descriphic
Export. .. Clagzification |
Yalue| Mame M-
0] Landclzss1 0

To delete an existing land cover type, select the land cover type to be deleted from the Land
Cover Type drop-down list and choose Delete from the Options menu. The selected land cover
type and all associated coefficient sets will be deleted from N-SPECT's database and will no
longer appear in the Land Cover Type drop-down list.

Note: The C-CAP land cover type cannot be deleted.
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Import Land Cover Type

3 Land Cover Types

Cptions = Help

e VpE:; |§new land cover v
Delete. ..

Impart. ..
Export... Clazzification |

Yalue| Mame CH-f
0] Landczlass1 0

bior: Inew land cover type descripti

3 Import Land Cover Type

Mew Land Cover Type Mame: |

Impart File: | =

The import function will allow you to use land cover data sets from other N-SPECT users without
entering them by hand. Other users can use the export function to save the land cover, curve
numbers, and cover factor in the appropriate format. To import a land cover type, select Import
from the Options menu. Name the file and navigate to the folder in which it is located. The
imported file must be an ASCII file containing a header row, followed by a row of comma-
separated values for each land cover class. The header row should contain the name of the land
cover type and a description, separated by a comma (no space). Each row must contain eight
fields ordered as follows: Value,name,Curve#-A,Curve#-B,Curve#-C,Curve#-D,CoverFactor,Wet.
Supply a name for the new land cover type when it is imported. The new land cover type will be
added to the Land Cover Type drop-down list.

Fae 1
' complete_ccap.txt - Notepad g@
File Edit Format Miew Help

Complete C-CaP, Full <Cap Landcover Coefficients -

0, Background, 0,0,0,0,0,0
1l,Mo Data,0,0,0,0,0,0
2, High IntEHSity Ceveloped, 0. 89,0.92,0.584,0,.95,0,0
3,Medium Intensity Ceveloped,0.77,0.85,0.9,0.92,0.01,0
4,Low Intensity Dewveloped, 0.61,0.75,0.83,0.87,0.03,0
5, Developed Cpen Space, 0.4%,0.6%,0,7%,0.84,0.005,0
6,cultivated Land,0.67,0.758,0.85,0.8%,0.24,0
7,Pasture/Hay,0.359,0.61,0.74,0.8,0.05,0
8,&rassland,0.3,0.58,0.71,0.78,0.12,0

9, 0eciduous Forest,0.3,0.5%,0.7,0,.77,0.009,0

10, Evergreen Forest,0.3,0.55,0.7,0,.77,0.004,0

11,Mixed Forest,0.3,0.55,0.7,0.77,0.007,0

12, scrubs/shrub,0.3,0.48,0.65,0.73,0. 014

13, Palustrine Forested wetland,o,0,0,0,
14, rPalustrine scrubSshrub wetland, o, 0,0,0,
15,Palustrine Emergent wetland,0,0,0,0,0,1
16,Estuarjne Forested wetland,0,0,0,0,0. 003

LR R ]
A7 re+riimmd e r el Sl T m A A S N
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Export Land Cover Type

-
53 Land Cover Types
Options  Help
MEw. . Mpe: |§new land cover P
Delete... tion: —
Import. .. : |new lard cover tppe descriptic
Export... Classification |
Yalue| Mame M-
0f Landclass 0

The export function will allow you to share land cover data sets with other N-SPECT users, who
can use the import function to load the land cover, curve numbers, and cover factor without
entering the values by hand. To export a land cover type, select the land cover type to be
exported from the Land Cover Type drop-down list, and choose Export from the Options menu.
Name the exported file and designate a location in which to save the file. The land cover classes
are written to a comma-separated ASCII file containing a row of values for each land cover class.
The file contains a header row with the name of the land cover type and the description. Each row
contains eight fields ordered as follows: Value,name,Curve#-A,Curve#-B,Curve#-C,Curve#-
D,CoverFactor,Wet.

3.2 Pollutants

The primary focus of N-SPECT is nonpoint source pollutants. N-SPECT applies coefficients
representing the expected pollutant load from each land cover type to approximate total nonpoint
source pollutant loads. The accuracy of N-SPECT’s pollutant results depends on these
coefficients. To apply the tool to other areas, you should develop coefficients based on local data
when possible.

Use the Pollutants dialog box to view or edit information about previously defined pollutants, to
define new pollutants, or to delete pollutants that are no longer needed. Use the Pollutants menu
to add or delete a pollutant. Use the Coefficients menu to create, copy, delete, import, or export a
coefficient set.

View or Modify Pollutant

To modify an existing pollutant, select Advanced Settings and Pollutants. Select the pollutant of
interest in the Pollutant Name drop-down list. The list will display all the currently defined
pollutants within N-SPECT. Fields in the Pollutants window are populated according to the
selected pollutant. Use the Coefficients tab to view or edit information about the defined
coefficient sets for the selected pollutant.
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&= Pollutants
Pollutants  Coefficients  Help
Pollutant Marne: |§Nitru:ugen ﬂ
Coefficients l Whater Quality Standardsl
Coefficient Set; |Nitru:ugen j Land Cowver Type: |
Dezcription: |
| | Clazz | Coefficients [mgL]
Yalue| Mame Typel Type? Typed Typed
0| Background 1] 1] 1] 1]
1| MNoData 1] 1] 1] 1]
2| High Intenzity Developed 222 1] 1] 1]
3| Medium Intenzity Developed 229 1] 1] 1]
4| Low Intengity Developed 1.77 1] 1] 1]
5| Developed Open Space 1.25 1] 1] 1]
E| Cultivated Land 2 68 1] 1] 1]
7| Pasture/Hay 248 1] 1] 1]
3| Graszsland 1.25 1] 1] 1]
3| Deciduous Forest 1.25 1] 1] 1]
10| Evergreen Forest 1.25 1] 1] 1]
11| Mixed Forest 1.25 1] 1] 1]
12[ Scrub/Shiub 1.25 1] 1] 1]
13| Palustrine Forested "Wetland 1.1 1] 1] 1]
14| Palustrine Scrub/Shub Wetland 1.1 1] 1] 1]
15| Palustring Emergent wetland 1.1 1] 1] 1]
16| Estuaring Forested " etland 1.1 1] 1] 1]
17| Estuaring 5crubShiub wWetland 1.1 1] 1] 1]
18| Esztuaring Emergent ‘Wetland 1.1 1] 1] 1]
13| Unconsolidated Shore 047 1] 1] 1]
20| Bare Land 047 1] 1] 1]
211w ater n n n n
Cancel |

Add Pollutant

To add a new pollutant, select Add from the Pollutants menu.

B Pollutants

Pollukants  Coefficients  Help

Pallutant Mame: | Mitragen j

Coeflicients l "whater CQuality Standards]

Coefficient Set; |Nitr|:|gen ﬂ Land Cover Type: |

Description: |Nitru:ugen coefficients for complete C-CAP clazsification]
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B3 Add Pollutant

Coefficients

Pollutant Mame: |

Coeffizients ]

Coeffizient Set:

Descrption:

Land Cover Type:

Complete C-CAP ﬂ

i

Clazz

Coefficients [mg-L]

Yalue

Mame

Type 1

Type 2

Type 3 Type 4:A_

B ackgraund

Mo Data

High Intenzity Developed

kedium |ntenzity Developed

Low Intenzity Developed

Developed Open Space

Cultivated Land

Pasture/Hay

L= e A e L o T B Y et =]

[arazsland

[An)

Deciduous Farest

2L
]

Everareen Faorest

—_
—_

Mined Farest

ey
I+

ScrubdShrub

—
(5

Paluztrineg Farested 'Wetland

—
.

Paluztring ScrubdShrub 'Wwetland

ey
n

Paluztring Emergent *Wetland

b
[=p)

E ztuaring Forested Wetland

el
-

E ztuaring Scrubd/Shrub ' etland

=L
o0

E ztuarine Emergent W etland

b
[An)

nconzalidated Share

D|o|oD|oD|Oo)|D|D)|D|D)|D]|D)|D]|D]|D])D)D)D])D|SD ]| S

D|o|oD|oD|Oo)|D|D)|D|D)|D]|D)|D]|D]|D])D)D)D])D|SD ]| S

D|o|oD|oD|Oo)|D|D)|D|D)|D]|D)|D]|D]|D])D)D)D])D|SD ]| S

| Cancel |

Pollutant Name: Provide a name for the new pollutant being added (limit of 35 characters).
Coefficient Set: Provide a name for the coefficient set to associate with the new pollutant.

Land Cover Type: Select the type of land cover that will be used to define new coefficients for
the pollutant being added.

Description: Provide a brief description (less than 100 characters) of the new coefficient set.

Class: The Value and Name columns contain the grid value and corresponding name for each

land cover class defined for the associated land cover type. These values cannot be edited.

Coefficients: Enter coefficients into the table for each land cover class. Only one type of

coefficient is required, so only one column must be completed, but the functionality to enter four
different types of coefficients is available. The coefficients give the average concentration of the
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selected pollutant that is released by the identified land cover during a precipitation event. This is
frequently referred to as the Event Mean Concentration.

Delete Pollutant

To delete an existing pollutant, select the desired pollutant for deletion and select Delete from the
Pollutants menu.

B3 Pollutants

Pollutants  Coefficients  Help

add...
Delete, .. : |N|trn:|ger'| ﬂ

Coefficients | ‘Water Quality Standards l
Coefficient Set: | Mitrogen j Land Cowver Type: |
D escription: \Mitrogen coefficients for complete C-CAP classification

Confirm the choice to delete when prompted. The pollutant, all associated coefficient sets, and all
references to the pollutant in water quality criteria will be deleted from the database.

3.3 Coefficients

Coefficients give the average concentration of the selected pollutant that is released by the
identified land cover during a precipitation event. This is frequently referred to as the Event Mean
Concentration.

-
&3 Pollutants
Paollutants =~ Coefficients  Help
Pallutan hlew Set...
Copy Set...
Coeffici Delete Set.. tandards l
Irnport Set...
Coeffi  Expork Set... -
Description: || ead Cosff Set

Add New Coefficient Set

To create a new coefficient set, select the pollutant for which you want to create a new coefficient
set in the Pollutant drop-down field and select New Set from the Coefficients menu. Designate a
Coefficient Set Name and associate a land cover type in the Land Cover Type field. Click OK and
a new coefficient set will be created, with the values defaulting to zero. Enter a description of the
coefficient set. Enter a coefficient for each land cover class defined for the land cover type.
Values must be entered for at least one of the four types (Types 1 through4).
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& Add Coefficient Set

Coeffizient Set Mame: |new_set_name

Land Cover Type: |§|:I:.&-.F' j

k. | Carnicel |

Copy Coefficient Set

To copy a coefficient set, select Copy Set from the Coefficient menu. Designate a coefficient set
to copy from and a new coefficient set name. The Copy from Coefficient Set drop-down menu will
contain all defined coefficient sets for the selected pollutant. Click OK and a new coefficient set
will be created that is identical to the coefficient set selected in the Copy from Coefficient Set
field. The coefficient values may be edited for the new set.

-,

53 Copy Coefficient Set

Copy From Coefficient Set: |LE:adSet ﬂ

MHew Coefficient S et Mame; |r‘|ew_|ea|:|_$et

k. | Cancel |

Delete Coefficient Set

To delete an existing coefficient set, select the desired coefficient set for deletion and select
Delete Set from the Coefficient menu. Confirm the choice to delete when prompted. The selected
coefficient set will be deleted from the database.

Import Coefficient Set

f =
= Import Coefficient Set
Mew Coefficient Set Mame: |impu:urt_-:u:ueff_set
Land Cover Type: |I:I:.&.F' j
Irpart File: | I
] | Cancel |

To import a coefficient set, select Import Set from the Coefficients menu. Specify a name for the
coefficient set to be imported and the land cover type that will be associated with it. Browse for
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the coefficient set file that contains the values to be imported. The imported file must be an ASCII
file containing a row of comma-separated values for each land cover class. Each row must
contain five fields ordered as follows: Value,Type 1,Type 2,Type 3,Type 4. The new coefficient
set will be added to the Coefficient Set drop-down list. The associated land cover type should
match the land cover values defined within the import file. The new coefficient set will be added to
the Coefficient Set drop-down list.

-~

o import_coeffset.txt - Notepad g@
File Edit Format  Wiew Help
P,2.22,0,0,0
3,1.77,0,0,0
4,2.68,0,0,0
5,2.48,0,0,0
7,1.25,0,0,0
&,1.25,0,0,0
10,1.1,0,0,0
16,0.%97,0,0,0
17,0.97,0,0,0
18,0,0,0,0

Export Set

To export a coefficient set, select Export Set from the Coefficients menu. Name the file and
designate a location to save it. The coefficient set will be written to a comma-separated ASCII file
containing a row of values for each land cover class. Each row will contain five fields ordered as
follows: Value, Type 1,Type 2,Type 3,Type 4.

3.4 Water Quality Standards

The final output is compared to user-specified water quality standards to assess the water quality
in the area. The pollutant name and threshold concentration are input to create a standard, which
can be stored in a group with standards for other pollutants, or alone.

Use the Water Quality Standards dialog box to view and edit all previously defined water quality

standards. Use the options menu to create, delete, copy, import, or export water quality
standards.
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53 Water Quality Standards
Options  Help
Standard Mame: |§L|:ung Term Criteria j
Description: |I:hr|:|r'|in: levels [barics] & levels not to exceed (M, K, TS5)
Puollutant Threshold [ug/l]
Phosphors A0
Mitrogen 280
Total Suspended Salidz 20
Zinc 22
Lead 29
| Cancel |

Modify Water Quality Standard
Water quality standards can be modified in two ways within N-SPECT:

1. To modify an existing water quality standard, select Advanced Settings and Pollutants. Select
the pollutant of interest in the Pollutant Name drop-down list. The list will display all the
currently defined pollutants within N-SPECT. Fields in the Pollutants window are populated
according to the selected pollutant. The Water Quality Standards tab is automatically
populated with any standards, their descriptions, and threshold values already defined for the
selected pollutant. The user will be able to view or modify the threshold for the pollutant in
this window.

24



-
&= Pollutants
Pollutants  Coefficients  Help

Pollutant Mame: |Leau:| ﬂ
Coefficients W ater Quality Standards l
M ame Description Threzhold
Shart Term Criteria Acute levels [howics] and levels not to exces 29
koderate Term Criteria Acute levels [howics] & levels not to exceed 29
Long Term Criteria Chronic levels [toxics] & levels naot to exces 29
| Cancel |

Name: The Name column on the Water Quality Standards tab is automatically populated with all
currently defined water quality criteria for the selected pollutant. This field cannot be edited.

Description: The Description column on the Water Quality Standards tab is automatically
populated with all currently defined water quality criteria for the selected pollutant. This field
cannot be edited.

Threshold: The Threshold column on the Water Quality Standards tab is automatically populated
with the values assigned to each water quality criteria for the selected pollutant. Threshold values
are in units of micrograms per liter. If no value has been assigned, the field will be empty. New
values can be entered or existing values can be modified in this window.

2. To modify an existing water quality standard, select Advanced Settings and Water Quality
Standards. The Water Quality Standards window is automatically populated with any
standards, their descriptions, and threshold values already defined for each pollutant. The
user is able to view or modify the threshold for the pollutant in this window. Once the
threshold numbers are modified, the new values will be saved.
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53 Water Quality Standards

Options  Help

Standard M amne; |§Sh|:|rt Term Criteria

=]

Dezcription: |E:-:arn|:|le Lewvels
Puollutant Threshold [ug/l]

Phosphors 150
Mitrogen 200
Total Suspended Salidz a0
Zinc 22
Lead 29

(] | Cancel |

Add New Water Quality Standard
A new water quality standard can be created in two ways within N-SPECT:

¢ Inthe Run Analysis project window, use the Water Quality Standard drop-down menu to
select New water quality standard. All the defined water quality standards will be listed in
this drop-down menu, but the last entry in the list will give the option to create a new

water quality standard.

e Select Water Quality Standards under Advanced Settings, and select New from the
Options menu. Either one of these options will take you to the Add Water Quality

Standard dialog box.

53 Water Quality Standards

Cptions = Help

Mew, .,

; |§Sh|:|rt Term Criteria

E

Delete, ..

Copy. ., |E:-:am|:|le Levels
Imnpork, ..

Export... Pollutant

FTIOERTIoN:

Mitrogen

Total Suspended Solids
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53 Add Water Quality Standard

Standard M ame "

Ciescriphion |

Follutant Threshold [La/l]

Lead

Mitrogen

Phozphorus

Total Suspended Solids
Zinc

| Cancel |

Standard Name: Provide a hame for the new water quality standard being added (limit of 35
characters).

Description: Provide a brief description (less than 100 characters) of the new water quality
standard.

Pollutant: This field is automatically populated with all currently defined pollutants. This field
cannot be edited.

Threshold: Provide a threshold value for each pollutant for the new water quality standard. The
values should be entered in microgram per liter (ug/l).

Click Save to add the new standard to the database and to the Standard Name drop-down menu.

Delete Water Quality Standard

To delete an existing water quality standard, select the desired water quality standard for deletion
in the Standard Name field and select Delete from the Options menu. Confirm the choice to
delete, and the selected water quality standard will be deleted from the database.

Copy Water Quality Standard

To copy a water quality standard, select Copy from the Options menu. Designate a standard
name from which to copy and a new standard name. The Copy from Standard Name drop-down
menu will contain all currently defined water quality standards. Click OK to create a new water
quality standard that is identical to the water quality standard selected in the Copy from Standard
Name field. The new water quality standard can then be edited and saved.
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53 Copy Water Quality Standard

Copy From Standard M arme: ||_.;.ng Term Criteria j
M ews Standard M arme: |ew_long_term_criterig
OF. | Cancel |

Import Water Quality Standard

To import a water quality standard, select Import from the Options menu. Specify a name for the
water quality standard to be imported. Browse for the water quality standard file that contains the
values to be imported. The imported file must be an ASCII file containing a header row, followed
by a row of comma-separated values for each pollutant. The header row should contain the name
of the water quality standard and a description, separated by a comma (no space). Each row
must contain two fields ordered as follows: pollutant,threshold. The new standard will be added to
the Standard Name drop-down list.

[

“ import_wq_standard.txt - Notepad g@
File Edit Format Wiew Help

Long Term Criteria,cChronic Tevels (toxics) & Tevels not to exceed (M, K, TS5
Phosphorus, 50

Mitrogen, 250

Total suspended solids, 20

Zing, 22

Lead, 25

Export Water Quality Standard

To export a water quality standard, select Export from the Options menu. Name the file and
designate a location in which to save it. The water quality standard will be written to a comma-
separated ASCII file containing a row of values for each pollutant. The file will contain a header
row with the name of the water quality standard and the description. Each row will contain two
fields ordered as follows: pollutant,threshold.
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3.5 Precipitation Scenarios

The intensity, length of precipitation event, and amount of precipitation that falls during an event
have a large impact on the amount of erosion that occurs during the rainfall. Erosion is calculated
differently using annual precipitation data than it is using event-specific data. The Revised
Universal Soil Loss Equation (RUSLE) is used to calculate average annual erosion with annual
precipitation data, while the Modified Universal Soil Loss Equation (MUSLE) is used to calculate
erosion from specific events and requires event-specific rainfall data.

A precipitation scenario must be specified to calculate runoff within N-SPECT. The precipitation
scenarios that are defined within N-SPECT can be modified, or new scenarios can be created. N-
SPECT also provides the ability to delete precipitation scenarios.

e o

B3 Precipitation Scenarios
Cptions  Help

Choose a precipitation zcenario to view or edit

Seenaria Mame: |.ﬁ.nnual Precipitation ﬂ

Diezcription: |.-'1‘-.nnua| Precipitation for W aianae

Precipitation Grid: |I::"-.N SPECT“wWaianaeData\annual_prec
Girid Units: | meters j
Precipitation Units: | inches j
Time Period: |.-’-\-.nnua| ﬂ Raining D ays: l?i
Type: |T wpe | j
| Cancel |

Modify Precipitation Scenario

To modify an existing precipitation scenario, select Advanced Settings, Precipitation Scenarios.
Fields in the Precipitation Scenarios window are populated according to the selected scenario.

Scenario Name: This field contains a drop-down list of all the currently defined precipitation
scenarios. Fields in the Precipitation Scenarios window are populated according to the selected
Scenario Name. This field cannot be edited.

Description: This box provides a brief description of the selected precipitation scenario. The
description for the precipitation scenario can be modified and saved.

Precipitation Grid: The precipitation grid contains spatial values for precipitation over the area of
interest. The name and path of the precipitation grid are displayed. To change the precipitation
grid associated with the scenario, use the browse button to select a precipitation grid for your
analysis and choose Add.

Grid Units: This field defines the cell size units (meters or feet) of the specified precipitation grid.
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Precipitation Units: This box defines the precipitation units (centimeters or inches) used in the
precipitation grid.

Time Period: This field specifies the type of precipitation scenario—annual or event—depending
on the precipitation data set that is being used. Annual precipitation events will use different
methodologies for estimating soil erosion than event-based precipitation events.

The annual and event types of precipitation scenarios for Wai'anae were developed in
conjunction with the Hawali'i state climatologist. See the N-SPECT technical guide for specific
details.

Raining Days: This number represents the average number of days in a one-year period that
have rain events that produce overland flow, in the area of interest. This parameter is very
sensitive and typically requires careful consideration. While it isn’t recommended that users
simply adjust this value to calibrate N-SPECT to local conditions, users are encouraged to
employ creative methods to accurately reflect spatial variation in raining days.

Type: This field specifies the rainfall type in the analysis region. The different rainfall types
describe the four synthetic 24-hour rainfall distributions developed by the Natural Resources
Conservation Service (NRCS). The National Weather Service’s duration-frequency data or local
storm data were used to develop these distributions. All of Hawali'i is Type | rainfall (see following
table for descriptions of rainfall types).

NRCS Rainfall Distributions

Type Description

Types | and IA | pacific maritime climates with wet winters and dry summers. Type IA is the least
intense rainfall.

Type Il Most of the country falls into this category. Type Il is the most intense short
duration rainfall.
Type llI Atlantic coastal areas and the Gulf of Mexico where tropical storms with large

24-hour rainstorms occur.

New Precipitation Scenario
A new precipitation scenario can be created in one of two ways:

¢ Inthe Run Analysis project window, use the Precipitation Scenario drop-down menu to
select New precipitation scenario. All the defined precipitation scenarios will be listed in
this drop-down menu, but the last entry in the list will give the option to create a new
precipitation scenario.

e Select Precipitation Scenarios under Advanced Settings and select New from the Options
menu. Either one of these options will take you to the New Precipitation Scenario dialog
box.
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3 Precipitation Scenarios

Options  Help

Mew, ., cipitation scenario o view or edit
Delete. ..

naria M amme: |i-’-¥.nnua| Precipitation

Descriptian: |.-’-'-.nnua| rainfall for Y aiar

Precipitation Grd: | £y NS PECT sl ANAE

(nid L it |meters

e -,

3 New Precipitation Scenario

E nter new zcenario information

Scenario Mame: ||

Dezcription; |

Precipitation Grid: | =
Grid Units: |

Precipitation L nits; |

Time Penod: |

Lol Lo Ll L

Type: |

k. | Cancel |

Scenario Name: Provide a name for the new precipitation scenario being added (limit of 35
characters).

Description: Provide a brief description (less than 100 characters) of the new precipitation
scenario.

Precipitation Grid: Use the browse button to select the precipitation grid to associate with this
precipitation scenario.

Grid Units: Specify the cell size units (meters or feet) of the specified precipitation grid. This
information may be found in the metadata for the precipitation data set.

Precipitation Units: Specify the precipitation units (centimeters or inches) that are reported in
the precipitation grid. This information may be found in the metadata for the precipitation data set.

Time Period: Specify the type of precipitation scenario, annual or event, depending on the type
of precipitation data you are using. Different methodologies will be used to estimate soil erosion
from annual precipitation data than from event-based precipitation data. To avoid confusion, your
scenario name should accurately reflect the time period you have chosen.

Raining Days: Enter the average number of days in a year that have overland flow associated
with a rain event.
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Type: Specify the rainfall type in the analysis region. The different rainfall types describe the four
synthetic 24-hour rainfall distributions developed by the Natural Resources Conservation Service
(NRCS). The National Weather Service’s duration-frequency data or local storm data were used
to develop these distributions. All of Hawai'i is Type | rainfall.

Delete Precipitation Scenario

To delete an existing precipitation scenario, select the desired precipitation scenario for deletion
in the Scenario Name field and select Delete from the Options menu. Confirm the choice to delete
when prompted and the selected precipitation scenario will be deleted from the database.

3.6 Watershed Delineations

Watersheds are a common and logical analysis unit for conducting water quality assessments.
The first step in creating a vector layer of watershed polygons is to load a digital elevation model
(DEM). N-SPECT incorporates functionality similar to that found in the Arc Hydro Tools extension.
A flow direction grid, flow accumulation grid, vector watersheds layer, and length-slope (LS) factor
grid are all generated when a new watershed delineation is created.

The watershed delineations that are already defined within N-SPECT are listed in the Watershed
Delineation Name drop-down list in the Watershed Delineations window. Fields in the Watershed
Delineations window are populated according to the selected watershed delineation name. N-
SPECT provides the ability to create a new watershed delineation, delete an existing watershed
delineation, and enter the unique components of a watershed delineation.

-,

B3 Watershed Delineations
Cptions  Help

Browze YW atershed Delineations
W atershed Delineation Mame: |Waianae ﬂ

DEM Grid: |

[k | J

r
Subwaterzhed Size: | J

W' atershed: |

Flaw Accurmulation Grid: |

LS Grid: |

Watershed Delineation Name: This field contains all the currently defined watershed
delineations within N-SPECT. Fields in the Watershed Delineations window are populated
according to the selected watershed delineation name.

DEM Grid: The DEM Grid field provides topography data for use in N-SPECT analyses and is
automatically populated with the DEM grid defined for the selected watershed delineation. This
field cannot be edited. The tool was developed and tested using 30-meter DEMs from the U.S.
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Geological Survey (USGS), although other DEMs may also be used. USGS digital elevation
models are available for download at http://data.geocomm.com/dem/demdownload.html.

Note: Care must be taken to ensure the grid cells of the DEM and land cover data sets (and all
other grid data sets) match. This can be accomplished by setting the Snap Extent to Feature of
the ArcGIS Spatial Analyst options menu to the DEM data set. See the N-SPECT technical guide
for more information.

Units: This field is automatically populated with the DEM grid units (meters or feet) defined for
the selected watershed delineation. This field cannot be edited in this window.

Hydrologically Corrected DEM: Select the Hydrologically Corrected DEM check box if you have
already hydrologically corrected the DEM by filling sinks. If this check box is cleared, N-SPECT
will automatically perform this hydrological correction process before creating the watershed
delineation.

Subwatershed Size: Subwatershed size designates the subwatershed size (small, medium, or
large) for the selected watershed delineation. The subwatershed size is relative to the DEM; a
small subwatershed is 3 percent of the maximum flow accumulation value, a medium
subwatershed is 6 percent of the maximum flow accumulation value, and a large subwatershed is
10 percent of the maximum flow accumulation value. This field cannot be edited in this window.

Watershed: This field displays the watershed file that was created in the watershed delineation
process.

Flow Accumulation Grid: This field displays the accumulation grid that was created when the
selected watershed delineation was created. Each cell in the flow accumulation grid contains the
total value of all cells upstream of that cell.

LS Grid: The LS Grid is the length-slope grid that is used in calculating erosion. Length-slope is a
parameter needed to use the MUSLE equation to estimate soil loss from a short-term rain event.

Add New Watershed Delineation
A new watershed delineation can be created in one of two ways:
1. New...
o0 Automatic delineation from user-specified digital elevation model.

o Inthe Run Analysis project window, use the Watershed Delineation drop-down
menu to select New watershed delineation. All the defined watershed
delineations will be listed in this drop-down menu, but the last entry in the list will
give the option to create a new watershed delineation.

0 Select Watershed Delineations under Advanced Settings and select New from
the Options menu. Either one of these options will take you to the New
Watershed Delineation dialog box.

2. New from existing data...

o0 Manual input of watershed delineation files. This option is designed for the power
user who wants to have maximum control over the DEM-derived data layers.
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New Delineation from User-Specified Digital Elevation Model

5 Watershed Delineations
Options  Help

MNew...

Mew from existing data. .. = W

Delete. ..
U mikz:
r
B Hew Watershed Delineation

Create a new waterzhed delineation

Delineation M ame: ||

DEM Grid | =

[ DEM iz hyrdologically correct [filled]

DEM Units: | -l

Subwatershed Size: | j

| Cancel

Watershed Delineation Name: Provide a nhame for the new watershed delineation being added
(limit of 35 characters).

DEM Grid: Browse to the DEM Grid that will be used for the analysis in the area of interest.
Units: Specify the DEM grid units (meters or feet) for the selected DEM.

DEM is hydrologically correct (filled): Select the check box next to “DEM is hydrologically
correct” if the DEM has already been hydrologically corrected by filling sinks. If this check box is
cleared, N-SPECT will automatically perform this hydrological correction process before running
the analysis.

Subwatershed Size: Select the subwatershed size to indicate the approximate subwatershed
size (small, medium, or large) for the selected watershed delineation. The subwatershed size is
relative to the DEM; a small subwatershed is 3 percent of the maximum flow accumulation value,
a medium subwatershed is 6 percent of the maximum flow accumulation value, and a large
subwatershed is 10 percent of the maximum flow accumulation value.

Note: This field cannot be edited in this window.

Click OK to derive the new watershed delineation and process all associated files.
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New from existing data:

Users can create a new watershed delineation using derivatives created outside of N-SPECT.

5 Watershed Delineations
Options  Help

MNew...

Mew from existing data... : W

Delete...
Lrits:
-
B3 New Watershed Delineation g@

Define ‘Watershed Delineatian

‘watershed Delineation Name: |

DEM Grid: | =2

Flow Direction Grid: | g
Flows Accumulation Grid: | =
Length-slope Grid: | =
wiatersheds: | =
] | Cancel |

Watershed Delineation Name: Provide a hame for the new watershed delineation being added
(limit of 35 characters).

DEM Grid: Browse to the DEM Grid that will be used for the analysis in the area of interest. This
grid should be hydrologically corrected.

Units: Specify the DEM grid units (meters or feet) for the selected DEM.
Flow Direction Grid: Select the flow direction grid.

Flow Accumulation Grid: Select the flow accumulation grid.
Length-Slope Grid: Select the length-slope grid.

Watersheds: Select the shapefile polygon that represents unique watersheds.
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Delete a Watershed Delineation

To delete an existing watershed delineation, select the desired watershed delineation for deletion
in the Delineation Name field and select Delete from the Options menu. Confirm the choice to
delete when prompted and the selected watershed delineation will be deleted from the database.

3.7 Soils

Soils data are used to estimate sediment loads using the NRCS-developed RUSLE and MUSLE
equations. RUSLE is used to estimate average erosion over time, whereas MUSLE is used to
estimate erosion from specific rainfall events. N-SPECT was developed using soils data from the
SSURGO database; however, any land soils data can be used in the tool provided the data are in
the appropriate format. The soils configurations that are defined within N-SPECT are listed in the
Name drop-down list in the Soils window. Fields in the Soils window are populated according to
the selected soil name. N-SPECT provides the ability to create a new soils configuration or delete
a soils configuration.

5 Soils MmE[X]

Options  Help

Soilz Configuration

M arne: |Waianae -

Soilz GRID: |E:'\NSP‘E CT'w aianaeDatah50IL51

Sailz K Grid: |E:'\NSP‘E CT4w alanasD atahS01L5K1

oK, C Cancel |

Add New Soils Configuration

To define a new soils data set, select Advanced Settings and then Soils, and select New from the
Options menu.

5 Sols =)

Dptions | Help

Mew, .. atian
|Waianae j

Soils GRID:  |C:ANSPECT WaianaeDatah50IL5 1

Delete, ..

Sailz K Grid: |E:'\NSP‘E CT4w alanasD atahSOILSK

36



FEL Soils Setup

[ ET |

DEM GRID: |

1y

Soilz
Soilz Data Set: |

Hydralogic: Sail Graup Attribute: |

L L [®

k. Factar Attribute: |

Advanced MUSLE Specific Coefficients
MUSLE Equation for zediment yield:
3% (@ gul K C*P LS
|95 b= |0BE

a=

Locally calibrated MUSLE coefficients can be entered above.

wharning: [ and gp are calculated in Engligh units [acre-feet and
cubic feet per second respectively]. “'a' and "B must be derived
accordingly.

k. | Cancel |

Name: Provide a name for the new soils configuration being added (limit of 35 characters).

DEM Grid: Browse to specify the DEM Grid that you are using in the analysis area. This should
match the DEM grid used in the watershed delineation process.

Soils Data Set: Select the soils data set (polygon shapefile layer) that contains soils information
for the area of interest. The soils data currently provided in N-SPECT were acquired from the
U.S. Department of Agriculture (USDA) NRCS SSURGO database. Although these data are
available for download on the Web, a few modifications are necessary before they can be loaded
into N-SPECT. See the N-SPECT technical guide for information on processing the soils data.
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Hydrologic Soil Group Attribute: Select the attribute in the soils data set that corresponds to
the hydrologic soil group information. The hydrologic group (hydgrp) is an attribute found in the
component table of the SSURGO database. The hydrologic group is assigned based on soil
infiltration rates. These are grouped into four categories, A through D, based on decreasing
infiltration (A = high infiltration, D = very slow infiltration).

Hydrologic Soil Group Definitions
Hydrologic Soil

Soil Group Characteristics
Group

Soils having high infiltration rates, even when thoroughly wetted and
A consisting chiefly of deep, well- to excessively drained sands or
gravels. These soils have a high rate of water transmission.

Soils having moderate infiltration rates when thoroughly wetted and
consisting chiefly of moderately deep to deep, and moderately fine to

B moderately coarse textures. These soils have a moderate rate of
water transmission.
Soils having slow infiltration rates when thoroughly wetted and

c consisting chiefly of soils with a layer that impedes downward

movement of water, or soils with moderately fine to fine texture.
These soils have a slow rate of water transmission.

Soils having very slow infiltration rates when thoroughly wetted and
consisting chiefly of clay soils with a high swelling potential, soils with
D a permanent high water table, soils with a claypan or clay layer at or
near the surface, and shallow soils over nearly impervious material.
These soils have a very slow rate of water transmission.

K Factor Attribute: Select the attribute in the soils data set that corresponds to the K factor. The
K factor (kffact) is an attribute found in the chorizon table of the SSURGO database. This factor is
derived from the amount of soil lost per unit of erosive energy in the rainfall, assuming a standard
research plot. It is an erodibility factor that quantifies the susceptibility of soil particles to
detachment and movement by water. The K factor is used in RUSLE and MUSLE to calculate soll
loss by water. The two most important factors related to soil erodibility are infiltration capacity and
structural stability. Low infiltration capacity would cause more surface runoff, and the surface is
less likely to be ponded, making soil more susceptible to splashing. Some properties that create a
high K factor value are high contents of silt and clay, or impervious soil layers. Areas without a K
factor value (disturbed soils) will be assumed to carry a K value of 0.30.

Advanced MUSLE Specific Parameters: MUSLE requires two constants that can be locally
calibrated to estimate event-based erosion. In the Advanced MUSLE Specific Parameters
section, the universal MUSLE equation is given under “MUSLE Equation for sediment yield.” The
user can enter locally specific constants into the text boxes under “MUSLE Equation for Sediment
Yield.”

Delete Soils Configuration

To delete an existing soils data set, select the desired soils data set for deletion in the Name field
and select Delete from the Options menu. Confirm the choice to delete when prompted and the
selected soils data set will be deleted from the database.
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4. Output

Output data sets are organized and displayed in the ArcMap table of contents using group layers.
Data sets that result from running an N-SPECT analysis for accumulated effects will include

Accumulated runoff volume grid (liters). This grid displays accumulated values of water
volume at each cell in the analysis area. These values are used in calculating the
pollutant and sediment concentration grids by dividing the pollutant/sediment
accumulation grid by the water volume to give a concentration.

Accumulated pollutant grid (kilograms). This grid displays the accumulated load of the
specified pollutant at each cell in the analysis area.

Pollutant concentration grid (milligram per liter). Each cell in this grid gives an estimate of
the concentration of the specific pollutant at that location. The user can easily identify
specific areas of concern that may be logical targets for further monitoring.

Pollutant assessment grid (milligrams per liter). Pollutant concentration grids are
compared with user-specified water quality standards and a pollutant assessment grid is
created for each pollutant. This grid shows how the estimated pollutant concentration
compares with the selected water quality standard in the receiving waters.

Accumulated sediment load grid (kilograms). A total sediment load grid is created for
each N-SPECT run for which the user chooses to calculate erosion.

Data sets that result from running an N-SPECT analysis for local effects will include

Local runoff grid (liters). This grid displays the volume of runoff from each cell in the
analysis area.

Local pollutant grid (milligrams). This grid displays the source areas of the specified
pollutant at each cell in the analysis area.

Local sediment load grid (milligrams). This grid displays the source areas of sediment
load for each N-SPECT run for which the user chooses to calculate erosion.

5. Metadata

Each data set that is delivered with N-SPECT has a metadata file associated with it that can be
viewed with ESRI's ArcCatalog. The same is true for each output data set that is created with N-
SPECT. Each time a new analysis is completed, metadata are created for each output data set,
which includes information such as the N-SPECT project the output file is associated with and the
parameters that were chosen to run the tool when the data set was created
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6. Hints and Acronyms

Right-clicking within the tables contained in the N-SPECT window will allow you to append a row
(add a blank row at the end of the grid), insert a row (insert a blank row above the current row), or

delete a row from the table.

ASCII American Standard Code for Information Interchange
C-CAP Coastal Change Analysis Program

DEM Digital Elevation Model

MUSLE Modified Universal Soil Loss Equation

NRCS Natural Resources Conservation Service

N-SPECT Nonpoint Source Pollution and Erosion Comparison Tool
NWS National Weather Service

RUSLE Revised Universal Soil Loss Equation

SCS Curve Number
SSURGO Database
USDA
USGS

Soil Conservation Service Curve Number
Soil Survey Geographic Database

U.S. Department of Agriculture

U.S. Geological Survey
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